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Congratulations for purchasing the Cyclopital3D Digital Hand Viewer, the first 
commercially marketed handheld digital stereoscope. This will be the first in a line of 
digital stereoscopic viewing products from Cyclopital3D and expect that you will be 
completely satisfied with your purchase. Please contact us if you have any questions or 
problems with your Viewer as we are committed to providing you with the highest level 
of customer service and quality products. We appreciate your business!

Ken Burgess 
President, CEO 

kburgess@cyclopital3d.com 
 

Tanya Alsip 
Vice President, CFO 

talsip@cyclopital3d.com

Viewer Features 

· Bright stereoscopic images with no ghosting 
· Stunningly wide field of view (FOV) provides the ortho-stereo perspective of most 

digital stereo cameras – you see the same FOV as seen by the camera 
· Stereoscopic zoom and pan 
· Holds thousands of stereo pairs on 16GB of combined memory 
· Completely portable, provides 4 hours of continuous viewing before recharging 
· Focus adjustment accommodates the vision of most people 
· Images can be organized into folders for rapid access 
· Fully coated precision optics with large, perfectly matched achromatic lenses 

provide a uniquely immersive viewing experience 
· High quality front surface mirrors provide crisp, bright and perfectly aligned images 
 
Viewer Package Includes 

Viewer unit with 2 Ainol V6000HDV Personal Media Players (PMP units) 
2 Chargers 
2 USB cables 
1 set of earphones 
1 Allen wrench/Hex wrench size .050 inch 
1 Microfiber lens cleaning cloth 
2 Disposable lens cleaning cloths for cleaning internal mirrors 
1 Quick Start Guide, (this) full manual is saved in PMP memory
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 Viewer Diagrams 
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Viewer Diagram Legend 

Note: Right and Left are referenced looking into the lenses. 
1. Left PMP power button (on top), press for two seconds to power Right PMP on  
2. Right PMP power button (on top), press for two seconds to power Left PMP on 
3. Left PMP “Down Arrow” (on top), use for correcting mis-sync condition  
4. Left PMP “Up Arrow” (on top), use for correcting mis-sync condition 
5. Focus knob, adjust for best focus 
6. Left PMP DC power-in port 
7. Right PMP DC power-in port 
8. Left PMP USB port 
9. Right PMP USB port 
10. Left PMP microSD card slot 
11. Right PMP microSD card slot 
12. Left PMP Volume control 
13. Left PMP Video out jack 
14. Left PMP Audio out / headphone 
15. Right PMP power switch (on bottom, MUST be ON to Use or Charge) 
16. Left PMP power switch (on bottom, MUST be ON to Use or Charge) 
17. Control panel, operates both PMP units simultaneously 
18. ¼ – 20 Tripod mount, for tabletop tripod or handle (not supplied) 
19. Port for Kensington cable lock 
20. Left PMP mounting set screws (4-40) 
21. Right PMP mounting set screw (4-40) 
22. Right PMP mounting set screw (4-40) 
23. Right PMP mounting set screw (4-40) 
24. Handle, for picking the Viewer up off a table or out of a box 
 

The Control Panel: 

C1. Power button. Used to power off the PMP units (will not turn the units on) 
C2. >|| button. Used to start and stop slide shows and exit image zoom 
C3. +Vol. Used to turn the audio volume up, and to zoom in on images 
C4. –Vol. Used to turn the audio volume down, and to zoom out on images 
C5. Up-Arrow. Used to go “up” in menus and backwards when viewing images 
C6. Down-Arrow. Used to go “down” in menus and forwards when viewing images 
C7. Left-Arrow. Used to go “right” in menus and as an “escape” or “back” button 
C8. Right-Arrow. Used to go “left” in menus 
C9. “M” button. Used to “select” a function or as an “enter” button  
 
 C1 

C3 

C7 

C9 

C2 
C4 
C5 
C8 

C6 
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Viewer Usage   

Your Viewer comes preloaded with a sample set of some of Ken’s favorite photos; we 
thought you might be excited to view the samples before loading your own images. 

1. Turn on power for PMP units by pushing and holding for two seconds buttons 1 and 2 - 
Switches 15 & 16 should also be in the “ON” position. Look into eyepieces to see the 
menu light up and confirm that both PMP units are powered up. Note: Menu text will 
be reversed due to the Wheatstone design of the Viewer. 

2. Using the control panel on the bottom of the Viewer (17), Press the right arrow key 
(C8) to advance the function menu until the photo (camera) icon is highlighted. Then 
press the middle “M” button (C9) on the control panel to “select” the function. Note, if 
you accidentally select the wrong icon, the left arrow key (C7) on the control panel acts 
as your “back” button. When you select the photo function you will see a menu of 
folders identifying which “Disk” to access. “Local Disk” is the memory built into the 
PMP unit; “External Disk” is the optional microSD card. Select “Local Disk.” Now 
you will see a folder named “Samples,” select it and you see a list of images, select 
again to view the image highlighted in 3D. 

3. When your images are on the screen you should use the focus knob on top (5) of the 
Viewer to find the best position for your clearest viewing. You may need to adjust the 
focus knob for images with subjects that are closer up or far away. 

4. Advance to the next image by pressing the down-arrow button (C6) on the control 
panel, press the up-arrow button (C5) to go backwards through the images. 

5. When you are done viewing turn off the Viewer using the power button (C1) on the 
control panel (17). 

Notes:  

· Very important!!  When charging the PMP units, the switches on the bottom of each 
unit (15 & 16) MUST be in the ON position. 

· The Viewer has a power save function that comes preset to turn the Viewer off after 30 
minutes of no activity. However, the PMP software is inconsistent and doesn’t always 
shut down for power save, so switching buttons15 & 16 to the “off” position is safest.  

· It's possible for the two PMP units to become mis-synchronized when viewing images; 
there are a few ways that this can happen, but the most common is when a button is 
accidentally pressed on the top of one PMP unit that advances the picture on that unit, 
but not the other. There are a few ways to recover from a mis-synchronized condition:  

1. Press one of the buttons labeled with an arrow on the top of the Viewer (3 or 4). 
One of the buttons advances to the next image on that side and the other goes back. 
Which one you need to press depends on which unit is “ahead” of the other. Try 
pressing one arrow and if that doesn't work, press the other arrow on the same unit 
twice. 

2. Another way to recover from mis-sync is to keep pressing the left arrow button 
(C7) on the control panel until both units are showing the same thing (menu), and 
then navigate back to where you were. 

3. Lastly you can turn both the units off (C1) and start over from power up. 
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The Ortho-Stereoscopic Perspective and 3D “Realism” 

One of the main benefits of a lensed stereoscope is the ability to view images with an 
“Ortho-Stereoscopic Perspective” (OSP).  The OSP is obtained when the physical 
Horizontal Field Of View (HFOV) of the viewed image is the same HFOV that the camera 
recorded. This is a very important factor in achieving the realism promised by 3D 
photography. 

Most digital 3D viewing systems (computer monitors or “picture frames”) provide only a 
very narrow HFOV as compared to “what the camera saw,” often resulting in severe 3D 
distortion. When a stereoscopic image is viewed with a HFOV that is narrower than the 
HFOV of the camera, the “stretch” in the z-axis makes objects in the scene look smaller 
than real life, like a scale model, causing the scene not to look “real.”  

In the “old days” the stereoscopes sold with stereoscopic cameras were “matched” to the 
cameras so that one always saw an ortho-stereoscopic perspective in the viewer. This was 
accomplished by using a lens in the viewer that had the same focal length as the (fixed fl) 
lens in the camera. Modern cameras with zoom lenses, and the numerous widely varied 
digital 3D viewing methods make Ortho-Stereo viewing much less probable these days. As 
a result most digital 3D is viewed with a HFOV that is way too narrow (except for 
telephoto shots that don't look real for other reasons). 

The Cyclopital3D Digital Hand Viewer (C3DV) is capable of presenting images with a 
physical HFOV of 50 degrees. This is wider than the HFOV of most digital cameras, so for 
a true OSP the image will usually not use the entire width of the screen.  

For example, the Fuji Real 3D W1 camera takes a picture with a HFOV of about 45 
degrees at it's widest (power on default) zoom. Un-cropped images with an aspect ratio of 
4:3 that fill the C3DV screen vertically will have a HFOV of about 40 degrees. This is 
slightly short of the OSP, but close enough to look real. If you set the Fuji to an image size 
that has an aspect ratio of 3:2 the un-cropped result will have a horizontal HFOV of 45 
degrees. This is pretty much exactly that of the camera. When set to a 3:2 aspect ratio, the 
Fuji W1 is essentially perfectly “matched” with the viewer to provide the OSP. 

The old “Stereo Realist” had a fairly narrow HFOV (32 deg) compared to todays cameras. 
Fortunately, it turns out that if you digitize a Realist image  and maintain the original 
aspect ratio, the un-cropped result will fill the C3DV screen vertically and have exactly the 
correct width to provide the OSP! 

For any camera, pretty much all but the most wide angle shots can be cropped to provide 
the OSP in the Cyclopital3D viewer. Usually this means cropping the image vertically so it 
shows up as wide as the original scene. Zooming in with your stereo camera reduces the 
HFOV as seen by the camera and can cause 3D distortion unless you also view the scene in 
a narrow format (or increase the stereo base). 

The immersive nature of a lensed stereoscope blocks out visual distractions, really putting 
you in the picture. Interestingly, the feeling of realism can also be enhanced by pointing 
the viewer in the direction the picture was taken, up or down. The hand-held stereoscope 
gives you the ability to do this. For instance if a picture was taken looking up a tree, point 
the viewer up when you're looking at that scene. It's really quite remarkable! It's all about 
reproducing the sensory input exactly, for each eye, and for the gravity sensors in each ear! 
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Preparing Images for your Viewer, step by step using StereoPhotoMaker (SPM) 

Digital stereo photographs are composed of two images, one for the left eye and one for 
the right. They can be stored in many different formats, in a single file or as separate files. 
One of the most common storage formats is “side by side” (SbS) in which both the left and 
right images of the view are placed next to each other and stored as one image in a single 
file. The SbS format has two variants, “wall-eyed” and “cross-eyed.”  In a wall-eyed SbS 
file the image intended for the left eye is on the left, in cross-eyed format it's on the right. 
The Fuji W1 camera uses a storage format with a file extension of “MPO”, in SPM the 
MPO format is treated as a wall-eyed SbS format. 

The Cyclopital3D Stereoscope (Viewer) is based on the Wheatstone design of the 1830's 
which incorporates mirrors to provide a wide Field of View (FOV). As a result the Viewer 
uses independent left and right files that must be flipped horizontally (mirrored) for correct 
viewing. The images may also be re-centered or offset in order to obtain the widest HFOV 
with the most comfortable viewing experience. 

Note that in the process described here the source images are assumed to be already 
mounted. That is that the alignment between the left and right views has been previously 
adjusted and the “stereo window” has been set, either automatically or by hand, as per 
normal for digital stereo photographs. MPO files from the Fuji are automatically 
“mounted” in the camera. However, you can have the images “re-mounted” using any of 
the algorithms supported by SMP by simply “checking” the “Auto Alignment” option in 
SPM (described below).  

Two “template” files to be used in the “Multi Conversion” dialog in SPM are supplied by 
Cyclopital3D in order to simplify the conversion process, which can be found on the root 
directory of either PMP unit.  

The template file named “SbS_To_C3DV_800.mcv” produces images that are 800 pixels 
wide, the other one named SbS_To_C3DV_2400.mcv produces images that are 2400 
pixels wide. Both templates also provide for “offsetting” the images to control centering 
and overall convergence. You can use either one, but the smaller images load faster and 
consume less memory. Larger images may look better when you zoom in on them using 
the zoom function on the Viewer. If you don't zoom in much it's better to use images that 
are 800 pixels wide. 

Preparing the Images 

Preparing images for the Viewer is a two step process, first you create properly formated 
temporary SbS files from your source MPO or SbS files using the “Multi-Conversion” 
dialog in SPM. Then you split the temporary files into their right and left components 
using SPM's "Lossless Jpeg Multi Conversion..." dialog. The resulting files are what get 
loaded onto the Viewer, the temporary files can be discarded. 

The dialog on the following page is the “Multi Conversion” dialog in SPM, use the 
“Restore File” button to load one of the template files supplied, this action will set most of 
the parameters in the dialog so all you have to do is set the input and output folders. 
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SPM Multi Conversion Dialog: 

 

Step by step instructions for using SPM to create files ready to load onto the Viewer: 
 

1) Start SPM and open the “File->Multi Conversion...” dialog 
2) Use the “Restore(File)” button to load either SbS_To_C3DV_800.mcv or 

SbS_To_C3DV_2400.mcv (depending on the output image size you desire). 
3) Set "Look in" to point to the source folder of SbS files you wish to process.  
4) Set "Output Folder" to a folder that will be used to store the SbS temporary files 

that will be created by this processing step.  
5) Press "Convert All Files"  
6) After the process completes, close the “Multi Conversion” dialog  

 
      Notes: 

· Either template will also work for processing MPO files directly off the Fuji W1.  
· If you want to “re-mount your stereo images, “check” also the “Auto Alignment” 

function (and set it's parameters as described in the SPM help system). 
· If your source (SbS) images are in “cross-eyed” format, check the “Swap 

Left/Right" option. MPO images from the Fuji W1 are in “wall-eyed” format. 
 

7) Next, execute the "Lossless Jpeg Multi Conversion..." dialog to separate the side by 
side temporary files into left and right files for the viewer. The options in the dialog 
should be selected as shown on the next page: 
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SPM Multi Conversion Dialog: 

 

The “Look in:” field should point to the directory that contains the temporary SbS 
files you created using the “Multi Conversion” dialog. The “Output folders” are 
where you will find the files that are ready to be transferred to the Viewer. Note, 
you can put both the left and right images into the same “Output Folder” by 
entering the same path in both the “Left Folder” and “Right Folder” fields. The left 
image names will end with “_l” and the right image names will end with “_r”. This 
convention is compatible with “CopyToC3DV.exe”.  

8) Press “Convert All Files” to create the files you will load onto the viewer. Load the 
left (_l) files on the Left PMP unit, and the right (_r) files on the Right PMP unit 
and your done. (see “Loading Images into your Viewer” below) Note: after this 
processing step is complete you may delete the temporary files created using the 
“Multi Conversion” dialog.  

 
Advanced Image Preparation options: 
 

The check mark in the “Save Borders” option of the “Multi Conversion” dialog tells 
SPM to use the parameters set in the “Boarder” dialog when saving the SbS image. 
The option is used in this procedure to control the “centering” of the images on the 
PMP units, which sets the overall convergence of the scene. It can also be used to 
better center the right and left images as seen through each eyepiece for people that 
have very narrow (less than 58 mm) or very wide (greater than 72 mm) eye spacing 
(interoculars).  As most people fall within this range, modifying the value from its 
“default” is usually not necessary. 
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If you do decide to modify the value you may consider creating multiple copies of 
your images on the viewer organized in separate directories for “Narrow”, “Normal”, 
and/or “Wide” eyed persons.  
 
The “offset from center” of each image is half the value set as the “L/R Space” 
parameter. This parameter is stored in the “Multi Conversion” template (.mcv) file, so 
it is set properly when you “Restore(File)” to load the settings in this dialog (even 
though it's not shown in the dialog). For images 800 pixels wide the “default” offset is 
40 pixels (20 pixels per side), for 2400 pixel wide images the “default” offset is 120 
pixels (60 pixels per side).    
 
You can set the offset to something other than 40 (for 800 pixel wide images) or 120 
(for 2400 pixel wide images). You might decrease the value of the offset to 
accommodate people with very narrow eyes, or increase it for people with very wide 
eyes. To do this, first load the appropriate .mcv file in the “Multi Conversion” dialog, 
then exit the dialog and use the “View->Border Options...” dialog from the main menu 
to change the “L/R Space” value to the desired total offset. Then re-enter the “Multi 
Conversion” dialog and change the "Width" setting to the total image width (800 or 
2400) minus half the new offset (half the “L/R Space”). Note, to change the border 
options you must have a stereo image loaded in SPM or the “View” menu option will 
be grayed out. Finally, you might want to save the new parameters in a new “template” 
by using the “Save” button in the “Multi Conversion” dialog. 

 

 
Note that everything in this “Border” dialog should be 0 except the L/R Space, which 
should be set to twice the distance each image will be shifted. 
 
Note also that you can just edit the .mcv file directly (with Notepad) to change the 
relevant parameters instead of using the rather complex process described above. 
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Loading Images into your Viewer 

Once you have appropriately formatted Left and Right image files you can load them into 
the Viewer from Windows computers using “Windows Explorer”, or by using the supplied 
CopyToC3DV.exe.  

Copy the left images of stereo pairs from your computer to the left PMP unit, and the right 
images to the PMP unit on the right (referenced looking into the lenses).  

For convenience, images may be organized hierarchically in a tree of folders. The image 
files are stored in (disk like) memory on the PMP units, in either built in memory (Local 
Disk) or on optional microSD memory cards (External Disk). Each PMP unit must be 
loaded separately. If two memory cards are used, one must contain the left images and the 
other the right, and they must be inserted into their respective Left and Right PMP units. 

The structure of folders and files MUST be identical on both the left and right PMP units. 
Any folder that exists on the left PMP unit must have a compliment on the right PMP unit. 
Complimentary folders must contain the same number of files (and folders) with “similar” 
names. The complimentary files and folders must be named so that they sort alpha-
numerically in the same sequence. One way to do this is to have all folders and files named 
identically on both the left and right PMP units, but this is not absolutely necessary. The 
characters may differ toward the end of a complimentary name pair, as long as they sort 
alpha-numerically in the same order on both PMP units. For instance, folders and files on 
the left PMP unit could have “_L” appended to the names, where and “_R” might be used 
on the right PMP unit. 

Some people like to keep both the left and right images of stereo pairs in the same folder 
on their computer, with the left images identified by a trailing “_L” (or _l) in the file name, 
while a trailing “_R” (or “_r”) identifies the right image of the pair. This is fine but it can 
make it difficult to copy just the left images to the left PMP and visa versa because 
“Windows Explorer” does not directly support doing so.  

To accommodate this storage format Cyclopital3D provides a program called 
CopyToC3DV.exe (found in the root folder of either PMP unit) to copy left or right image 
files stored in a single folder to the correct PMP unit. If you point CopyToC3DV to a 
directory that contains both sides of stereo pairs in separate image files, it will copy only 
the images with the trailing “_L” (or “_l”) in the file name to the left PMP unit and only 
the images with a trailing “_R” (or “_r”) in the file name to the right PMP unit.  

Note: It is no longer necessary to use CopyToC3DV.exe to copy stereo images to the PMP 
units as it was with PMP firmware versions prior to 10810. You may now use “Windows 
Explorer”, or “Finder” (on Apple computers) for this purpose. 

There is no installation required for CopyToC3DV, you may execute it “in place” by 
double clicking on it in “Windows Explorer”, or you may wish to copy it to your desktop 
for easy access. The program is Windows only and requires that you have Microsoft's 
“dotNet” installed on your computer. If you don't already have it you will get an error 
message when you run CopyToC3DV, in that case just go to: 
http://www.microsoft.com/NET/ and click “Install It Now...” Any version 2.0 or later will 
work fine.  
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When you run CopyToC3DV you will see the following dialog: 

 

 

Using microSD memory cards 

Memory cards work just like internal memory in the PMP units, again you must make sure 
the file structures on the cards for the left and right units match, meaning that all files and 
folders sort alpha-numerically in the same sequence. To view images stored on microSD 
cards select the “External Disk” option under “Photo” in the main menu instead of “Local 
Disk”. With microSD cards the image storage capacity can be extended up to 64 GB total. 

 

For Apple Users 

There is no specialized support for converting images (splitting, mirroring and resizing) on 
a Mac or for transferring images from your Mac to the Viewer. However we recommend 
using “Boot Camp” or another Windows emulator to run SPM. Mac computers will 
recognize the PMP units and present their file systems as per normal. You can copy the left 
and right directory trees of images to the PMP units using “finder.”  
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Loading and Viewing Video and Video “Slide Shows” 

The Viewer was developed primarily for the purpose of viewing 3D still images, however 
the PMP units do support video playback, with sound, in the following video formats: 
AVI, RM, RMVB, FLV, DAT, MOV, MPG, PMP, VOB. An impressive list, but each of 
these formats may also have different “flavors” or options, you will have to do a bit of 
testing yourself to make sure your video files are compatible with the PMP units.  

The way stereoscopic video is synchronized in the Viewer is by starting both sides playing 
at the same time. The units are not “gen-locked” and do not support “frame accurate” video 
synchronization, however synchronization might be “good enough” depending on how 
much motion is in your video recordings. If all your doing is playing still image “slide 
shows” using a video format to do the sequencing, pan and zoom (ala Ken Burns) and 
synchronized audio it should work fine. 

The PMP units also support wired video out (13) that shows everything seen on the LCD 
panels (menus, images, video etc.) on a alternate video display when connected. The wired 
video output formats supported by the PMP units range from NTSC Composite video to 
HD (1980x720p) component (RGB) output. So, at least theoretically you could drive two 
AV projectors and a sound system with the Viewer for stereoscopic projection to a group.  

Please check the Cyclopital3D website for more information on the subject of video 
support in the Viewer. We will be posting more information as we hear from customers 
about their desires, successes and issues with 3D video. 
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Miscellaneous Functions 

· Setting background wallpaper. When viewing an image you may decide you would like 
to use it as the “system background” or “wallpaper.” To do so press “M” (C9) on the 
control panel and you will be presented with a list of options. “Set Wallpaper” is the 
last one on the bottom, use the “Down-Arrow” button (C6) on the Control Panel to 
highlight it and then press “M” again. Press the “Left-Arrow button (C7) to exit the 
menu. 

· Setting image transition format. You can setup different graphic effects for the 
transition from viewing one image to the next in the viewer. The “default” is a simple 
replacement, but you can do sweeps etc. instead. To change the transition type, press 
“M” (C9) while viewing any image. You will get the menu described above, select 
“switch mode” and choose the transition you like. 

· Automatic slide shows.  You can enter a mode that automatically switches to the next 
image after a preset time by pressing the >|| button (C2) on the control panel while 
viewing an image. Press the same button again to stop the automatic slide show. The 
time images remain on the screen can be set using the same menu described above for 
setting the wallpaper. It is the first option called “timeslot”. You can set it to 1, 3, 5 or 
10 seconds. Note, unfortunately the timing for switching to the next picture is not 
really accurate enough to work for very long when viewing in 3D, after a time the two 
PMP units will fall out of Sync. This may be fixed in a future PMP firmware update, 
but for now the slide show function is not really very usable. 

· Zooming and Panning on images. You can zoom in and pan around on images while 
you are viewing them in 3D. Pressing the +Vol button (12) on the control panel zooms 
in, and pressing the -Vol button zooms out. While you are zoomed in the arrow buttons 
on the control panel can be used to pan around on the image. There are three zoom 
levels up to a maximum of 3X 800x480 or  2400 x 1440, if you are going to use zoom 
your images should be sized to be at least this big. 

· We set some of the options in the PMP units different than their “factory default” 
values, specifically as follows: 

In the Settings menu: 

�  Language �  English 

�  Auto Power Off (inactivity time before power off) �  30 min 

�  Screen Close (inactivity time before backlight turns off) �  1 min 

�  Brightness �  Level 5 (maximum brightness) 

In the menu obtained by pressing “M” (C9) while viewing an image: 

�  Timeslot �  5s (for “slide shows”) 

�  Switch Mode �  Default (no “transition” between images) 

�  Wallpaper �  To one I happen to like ;-) 
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Power Management and Charging 

· IMPORTANT: The power switches (15 and 16) on the bottom of the PMP units MUST 
be in the ON position when charging. If the power switches are in the OFF position the 
PMP units will NOT charge. 

· You must press both buttons (1 and 2) on the top of the PMP units for at least two 
seconds to turn the PMP units on. You can turn both PMP units off by pressing the 
“POWER” button (C1) on the control panel.  

· Your Viewer has built in batteries and can operate for up to 4 hours of continuous use 
on a single charge. Recharging of fully drained batteries can take up to 3 hours. A 
battery charge indicator is displayed in the upper left corner when the main menu is 
showing, they may be different for right and left so close one eye to see them 
separately. 

· Your Viewer control panel (17) uses a 3V lithium battery, CR2025. The control panel 
is attached to the bottom of your Viewer with several sturdy pieces of Velcro and can 
be removed when a battery change is necessary. 

· To charge you PMP units simply plug in your AC adapters and connect them to the 
PMP units (6 and 7). Each PMP unit has it's own battery and must be charged 
separately. 

· There are two types of chargers available, one that plugs into the Power-In Port (6 and 
7) and another that plugs into the USB port (8 and 9). You received two of one type or 
the other. In any case you may charge the PMP units through their USB ports by 
plugging them into a computer or a generic USB charger.  

· When you plug the units in to charge they will turn on automatically. However, when 
charging is complete and you unplug the units they will stay on and may drain the 
batteries. Be sure to turn the units off after charging if you don’t intend to use them 
right away.  

 

Care and Maintenance 

Use the lens cleaning cloth that was provided with your Viewer, or a similar microfiber lint 
free cloth to clean lenses. Do not spray liquid directly onto the Viewer and avoid getting 
any moisture in any openings. 

If it becomes necessary to clean the LCDs on the PMP units, the mirrors, or the backside of 
the lenses you may gain access by removing the PMP units from the side. Simply loosen 
the two set screws that hold each one in place using the 0.050” Allen Wrench provided and 
pull the unit outward. Be careful not to scratch the front surface mirrors, they are coated for 
scratch resistance but are still somewhat vulnerable.  Use the sterile, disposable cleaning 
clothes for internal cleaning. 
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Technical Notes 

· The PMP units used in the Viewer are manufactured by Ainol, a Chinese company. We 
chose these units because they are currently the best available for the purpose of hand 
held 3D viewing. The displays are of the LTPS variety, which have the smallest 
spacing between pixels of any LCD type and the colors are rich and beautiful. The 
units are too complex to document all the features they support here, this manual 
documents the functions you need to view 3D photos.  

· Keep an eye on our web site and we'll let you know if Ainol provides an update that 
significantly improves the function or usability of the 3D Viewer. If that happens we 
will post the update and instructions for how to do it on our web site. 

We will also be updating this manual and the Viewer support software as we get 
suggestions from our customers. So check in once and a while and please let us know what 
we can do to make the system better. 
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Troubleshooting 

· Left/Right image synchronization errors. At some point the two PMP units may get 
“out of sync”. There are a few ways that this can happen, but the most common is 
when a button is accidentally pressed on one PMP unit that advances the picture on that 
unit, but not the other. There are a few ways to recover from a mis-synchronized 
condition:  

1. Press one of the buttons labeled with an arrow on the top of the Viewer (3 or 4). 
One of the buttons advances to the next image on that side and the other goes back. 
Which one you need to press depends on which unit is “ahead” of the other. Just try 
one, if that doesn't work, try pressing the other one (twice). 

2. Another way to recover from mis-sync is to keep pressing the left arrow button 
(C7) on the control panel until both units are showing the same thing (menu), and 
then navigate back to where you were. 

3. Lastly you can turn both the units off (C1) and start over from power up. 

· Image folders out of sync in Photo->Local Disk menu. If you accidentally enter 
“Record” mode (microphone icon in the main menu) a folder on the “Local Disk” 
named “record” will be automatically created by the PMP unit. If this happens on one 
unit and not both the folders on the two PMP units will be “out of sync”, to remedy the 
situation simply delete the “record” folder. There are two ways to do this: 

1. Connect the PMP unit to your computer using USB (8 or 9) and delete the folder 
using Windows Explorer. 

2. Delete the folder by using the buttons on the PMP unit itself (not the control panel). 
To delete the folder first highlight it under Photo->Local Disk using the control 
panel. Then quickly press the top power button (1 or 2) on the PMP unit that has 
the “record” folder highlighted. You will get a menu with the first option “delete” 
highlighted. Press the button on the opposite end of the same PMP unit twice (the 
button is not labeled on the case, but actually performs the “enter” or “select” 
function). The first press is to select the “delete” function, the second is to confirm 
the deletion. 

· If somehow a PMP unit gets set to a language other than English it can be set back to 
English using the icon that looks like a “globe” in the settings menu (gear icon). 
Choose the middle option for English. Unfortunately the only languages supported are 
Chinese, simplified Chinese, and English. 
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Technical Support 

Your Viewer purchase comes with a lifetime of free technical support and firmware 
upgrades, and 90 days of hardware repair coverage, which commences on the shipping 
date. 

If you experience persistent technical problems after reading the troubleshooting 
recommendations in this manual and checking our website, http://www.cyclopital3d.com 
for additional troubleshooting information, you may send an email to 
kburgess@cyclopital3d.com for technical support. Support requests will normally be 
responded to in 24 hours. 
 

Viewer Specifications 

· 800 x 480 resolution (each eye) 
· Fully coated achromatic lenses 
· Scratch resistant front surface mirrors 
· Uses two Ainol V6000HDV PMP Units for image storage and display 
· 8GB of storage per PMP unit for a total of 16GB 
· Size: 200mm x 120mm x 95mm (7.9” x 4.75” x 3.75”) 
· Weight 850 grams (1 lb 14 oz) 
 

Product Warranty 

The Cyclopital3D Digital Hand Viewer includes with a 90-day warranty against 
manufacturing defects in material or workmanship. It is warranted for normal use; abuse of 
the product is not covered. If you drop it, it will break. 

The Ainol Personal Media Players include a separate manufacturer warranty that is 
transferred to the owner of the Cyclopital3D Viewer. But, if a PMP unit should fail you 
may contact Cyclopital3D and we will attempt to provide technical support or possibly 
replace the unit for you. 
 

Caution:  this is a delicate precision product and should be treated with the same care 
given to any fine camera or lens. Do not apply excessive force to the focus mechanism or 
lens barrels. 

 

Ó 2009 Cyclopital3D, Incorporated. All rights reserved. 


